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drive.web automation
This product is designed to conform to CE and UL standards:

EMC Standard, EN 61326-1: 2006, Electrical Equipment for Measurement, Control and
Laboratory Use.

Emissions Class A, Commercial Equipment.
Immunity Table 2, Industrial Equipment.

LVD Standards, EN 61010-1: 2010, Safety Requirements for Electrical Equipment for
Measurement, Control and Laboratory Use and;

EN 61010-2-030: Particular Requirements for Testing and Measuring Circuits.

speedy is an industrial controller designed for permanent installation by qualified professionals.
If it is used in a manner not specified herein the protection provided may be impaired.

speedy and its packaging contain recyclable materials.
This device is designed to comply with Part 15 of FCC Rules. Operation is subject to the following

two conditions: (1)This device may not cause harmful interference, and (2)this device must
accept any interference received, including interference that may cause undesired operation.

This Class [A] digital apparatus is designed to comply with Canadian ICES-003. Cet appareil
numerique de la classe [A] est congu conformer a la norme NMB-003 du Canada.

A Warning! It is essential that you read and understand this entire manual and the entire
contents of the savvy software Help menu before proceeding with your installation and
configuration. See page 9 for savvy installation instructions. For more information and to
download manuals and software, go to wwuw.driveweb.com or contact us. See page 24.

Warning! Your use of savvy software and drive.web devices may cause motors and
machinery to power up with high Voltages or start or operate in an unexpected, dangerous or lethal
way. It is essential that you are completely familiar with all of the equipment and the system design
before attempting to program or edit a program or connect to any live device. It is also essential that

Aa risk assessment is conducted to identify hazards. Risks must be reduced to tolerable levels.

Warning! You are entirely responsible for the configuration or use of any drive.web product.
By configuring or using these products you agree to indemnify and hold harmless Bardac
Corporation, its’ employees, directors, officers, distributors and resellers against the consequences of
your configuration or use of the products.

Warning! Information in this manual is subject to change without notice. You are responsible
for verifying the proper operation of your speedy module. Special care must be taken after loading
! new firmware or installing new options.

Warning! Avoid permanent damage to your speedy, never exceed any min or max values.
Do not connect any speedy terminal to mains circuits. See page 8 for 1O ratings.

IwIP is incorporated into speedy firmware. IwIP Copyright (c) 2001-2004 Swedish Institute of Computer Science. All rights reserved.
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

3. The name of the author may not be used to endorse or promote products derived from this software without specific prior written permission.
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ""AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING,
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVI LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOV ER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER TN COI\TRACT STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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drive.web automation

Product identification, speedy model number

speedy is a range of programmable devices using drive.web distributed
control over Ethernet for industrial process automation. To program and use
a speedy you must get the savvy software tools from wuwu.driveweb.com.
Please see pages 9 to 12.

To find the speedy’s firmware version, launch savvy, choose Get Detailed
Info from the speedy contextual menu. See pages 11, 12.
dw220 generic ModbusRTU master up to 500kbps.
dw22e2 for ODE-2 variable frequency drive.

dwe23 for ODP open-loop vector drive.

dw225 for Yaskawal7 inverter drive.

dw226 for HVAC variable-torque AC pump and fan drive.

Basic speedy standard features

“““““ drive.web distributed process control.

™., 10/100Base-T(X) Ethernet, page 6

" Field upgradeable firmware

" Ultra-compact design may be permanently bonded inside equipment.

" High-speed ModbusRTU on EIA485. Up to 500kb/s.

" Drive-dedicated models can bus-share EIA485 network to control or
monitor additional servers at different addresses. See page

™. E-Mail Notify block, outgoing SMTP mail server support, page 11.
™. Basic Control Function Block Library. See savvy User Manual for listing,

speedy options

Software options may be added using savvy. See page 13. See
savvy User Manual, Appendix A for function block listings.
04 ModbusTCP/IP Slave/Server. See page 18.

05 Process Control. Function Block Library 1. e
06 Winder Control. Function Block Library 2. See page 19.
10 Advanced Math. Function Block Library 3.

25 EIP/PCCC Slave/Server. See page 18.

26 savvyPanel Operator Station Interface. See pages 14 to 17.[
29 Solar with Sun Position calculator. S 38

50 DIN rail mount with terminal block wiring. R D)D)
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speedy Specials

Generic engineered solutions include required options (in
parentheses), system configuration and wiring diagram. Contact us
for many other engineered solutions. Options may be added.

-1101 Open-loop Constant Tension Genter Winder (05, 06)
-1102 Closed-loop Dancer Control Center Winder (05, 06)
-1103 Closed-loop Loadcell Control Center Winder (05, 06)
-1104 Slip Core Winder (05, 06)

speedy Installation

speedy is designed for permanent installation by qualified professionals.
Warning! Dangerous, High Voltages that may cause
injury or death are present on drives, motor controllers and
other industrial devices!
Only qualified personnel who are completely familiar with the &
system that the speedy will connect to should proceed!
Environment: UL/IEC Pollution Degree 2, Operating
temperature, 0°C min., 50°C max. Altitude 3000m max. Storage
temp, -20°C to 60°C. Humidity 95% max. non-condensing. Install
in metal enclosure with no RF noise source

Dimensions & Clearances:
1”’ clearances must be provided on three long sides to promote airflow.

Standard model with DIN rail mounting option

48mm

1.42”

57mm
2.24”

36mm

23mm ,
0.91> 1.42 0.01”
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speedy Installation continued...
Weight: Standard-19g(0.70z). w/ DIN rail & terminals - 28g(1.00z)

Power requirements: Regulated 24VDC £10%, 40mA. Do not
connect to a distributed DC power network.

Serial port EIA485(RS485) 0.1 to 500Kbps. Unisolated, power

and serial circuits must have compatible common-mode Voltages.

Ethernet port MDI 8P8C, “RJ45” jack, 100baseTX, 10BaseT,
Full Duplex, Auto Negotiation, Auto-MDIX, IEEE 802.3ab.

USB port Peripheral-type Micro-B jack.

Ethernet LEDs For sctup, troubleshooting and monitoring:
100 Green LED indicates 100BaseTX Ethernet connection.
Link / Activity Yellow LED. On for Link, flashing for activity.

Adhesive Mounting. Clean adhering surfaces with alcohol first.
Use caution, bond is permanent. Adhere on or near the drive
or EIA485 device. Do not obstruct air vents, access points or
product labels. Do not attach speedy near hot spots such as
heatsinks, cooling fans, etc., nor near to AC power lines.

DIN rail option. Use 35x7.5mm rail per IEC 60715, EN50022.

Terminal wiring: Strip 7mm(0.28”) or use ferrules. Use
0.2mm? (AWG24) minimum. One wire, 2.5mm? (AWG12)
maximum. Two wires, 1.5mm?(AWG14) maximum. Two
wires with ferrules, Imm? (AWG18) maximum.

Terminal tightening torque: 0.5 Nm (4.4 in‘lbs)

Signal wiring notes. Use twisted-pair wiring. All wiring
outside of the metal enclosure should be shielded cable with
individually shielded twisted-pairs such as Belden 8163.
Ground the shield at only one end with a 360° clamp where
the shield enters your metal enclosure. Separate all wiring
from RF noise sources and AC power cabling,
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speedy power and serial connections

dw220 24V
standard 15”, 24AWG, oV, C
solid-wire connections. A

B

with DIN rail mount option.
Single, local device connections.

dw225
standard 157, 24AWG,
solid-wire connections.
YF7 Wire
terminal | name
SP 24V

1G and SN oV, C 24V

S- and R- A ov

S+ and R+ B A
with DIN rail option. B
Single, local device connections.

speedy HG503206beta?2 wwuw.driveweb.com
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speedy serial port connections continued...

Name | EIA485 name |[Modbus name Description
A A or Data — Do Inverting Pin
B B or Data + D1 Non-Inverting Pin
C SC or Data 0V Common Common Reference

",A and B must share a single twisted-pair. ¢ may use one or both

conductors in another pair. Do NOT pair € with other signals.
™. EIA485 Common Reference is required. It is named C so that it is not
confused with other common, ground or shield connections.

".Correct multipoint topology is daisy-chain or trunk with device at each

end and additional devices on short stub branches. Star, ring, or
extended branch topologies are NOT recommended.

",Connect line termination between A and B at both physical ends of a

ModbusRTU network, typically 150€2, 0.5W or for networks with line
polarization, 1202, 0.25W and InF, 10V cap in series. Do NOT provide
line termination on any network with an Optidrive.

Drive setup

speedy| Supported Required drive settings Related drive
model drive settings
dw220|Generic Baud-rate, framing Serial loss behavior
dw222|0ptidriveF2 P-36; Address = 1, P-36, Comms Loss Trip
Baud rate= 115.2Kbps Enable
dw223|OptidrivePlus P2-26, Baudrate = 115.2Kbps  |P2-26, T, trip or R,
P2-27, Address = 1 ramp on serial loss
dw225]YaskawaF7 H5-01 = 1F decimal 31 H5-04 Stopping Method
H5-02 = 4, 19.2Kbps H5-05 Serial Fault
H5-03 = 00, No parity Detect
H5-06 = 05, Min. delay 5ms
dw226|OptidriveHVAC [P-36; Address = 1, P-36, Comms Loss Trip
Baud rate= 115.2Kbps Enable

dw223 Optidrive Plus Notes

4+Check drive model number and firmware version. P0-28 and

P0-29 should indicate 2.2 or higher. Model number must end in -M for
firmware versions prior to 3.0.

speedy HG503206beta?2
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Drive setup continued...

dw225 Yaskawa YF7 Notes

., .Check Flash ID, U1-14 = 3020.

“”“W‘Check internal line termination switch S1-1.

" You must cycle the YF7’s power, waiting for the screen to
blank, before re-powering, in order for parameter changes
to take effect.

speedy Ethernet Networking & Programming

Before proceeding, it is important to have a basic
understanding of Ethernet TCP/IP networks. Assigning an
invalid or duplicate IP address will cause serious network
malfunctions! speedys are all shipped with the same IP
address, 10.189.189.189. Consult your company’s IT
department for an appropriate, unique IP address.

"..Find useful networking information. Under the Help menu
click on User Manual. Scroll down to the Basic
Network Administration section.

Set up Your Physical Ethernet Network - You Will Need:

wA  standard Category 5Se cable with 8P8C/R]J-45
connectors on both ends for each drive.web device and
your computer.

wlor systems with more than one drive.web device, an
Ethernet switch with ports for all drive.web devices and
your computer.

Set up Your Computer - Get savvy

With free drive.web savvy software, easily program and

monitor your speedy, perform data trending and create

distributed control systems.

"/ To download the latest version of savvy go to
wuwuw.driveweb.com and click on Get savvy.

", Java Runtime Environment must be installed to run
savvy. There is a link on the Get savvy page to
download Java for free.

" If you do not have internet access, install savvy and Java
from the Bardac Infodisk. Browse to the savvy link,
off-line installation. Contact us for the files or Infodisk.
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drive.web automation

Get started with savvy continued...

Device Directory window, sclect File > Administrate > Set
IP Addresses for System. The serial number marked on
your speedy is its MAC Address. Enter a unique IP
address within your computer’s subnetwork, click OK.

"../A speedy icon should appear with IP address beneath.

" If the icon at right appears, a network connection problem a
exists. Check connections, LEDs and that the speedy IP 5%
address 1s within your computer’s Ethernet subnet mask.

Device Directory window, sclect Directory menu. 10.189.189.189

" .Discover All Local Devices. When speedy is powered .
up and connected to the same local network as your u
computer, an icon should appear. ==

"..Discover Device... Anywhere on the internet via a public
IP address, VPN or similar. 192.168.1.25

" Advanced Users: At the bottom of the Set IP
Addresses window, click the arrow next to
Network Information to set subnet mask,
router, SM'TP mail server and SN'TP time server
IP addresses. See the savvy user manual.
Note! If the Network Information box is )
expanded, this network information will be set in = e
the device(s) whose IP address(es) are changed.

Warning! Importing a configuration into your speedy A
will result in immediate execution of that configuration.
Dangerous Voltages and rotating machinery may &
result!.Use a phantom to preview a configuration.

"..Directory > Import | Export Data. All device
configurations and drive.web connections between
devices in the directory.

speedy contextual menu (via right-click or hover-button) U

", .Change Name. Name your speedy for easy identification. —

" Import Device Data | Export Device Data... Load /
save configuration data to / from this speedy only. Laminator Stage 2

speedy HG503206beta2 wuwur.driveweb.com Page 10/20
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Get started with savvy - speedy contextual menu continued...

" .Find Parameter... Enter parameter number, name or
partial name to view it.

"..Unlock, Lock, Set Password. The speedy at right is
locked to Restrict Modification. Viewing configuration
1s possible. The speedy below it is locked to Restrict All
Access. Select lock type when setting password.

Click the speedy icon to view the Device Overview Laminator Stage 2
screen (Standard savvy, no SFD). Click the Oveérview
Function Block Engine icon or, if you have options e ine

04,17 to 19, 25, the Comms Server icon to view.

Function Block Engine Window. Sclect FBE menu
(Standard savvy, no SFD), and add function blocks in
the order to be processed. Processing order is from left to
right, then top to bottom.

Click on function block to view parameters and function detail.

Warning! Making a connection will result in immediate
i execution of that connection. Dangerous Voltages i

and rotating machinery may result!.

Connect between parameters and to parameters in other
drive.web devices over Ethernet.

"..Under the File menu, choose New Viewer... and then
Open Device Directory. With two viewer windows,
click on a parameter, drag a connection and drop onto
a destination parameter in the other viewer.

Parameter contextual menus (via right-click or hover-button)

™. .Most parameter data is 16-bit. Raw decimal integer values
0 to 65535 or £32767. Data is formatted, limited and
scaled depending on the parameter. Use Get Info or Re-
Scale... to verify or change.

Click parameters to open a setter box. Adjust value {[# [] 6
with convenient graphical buttons or keyboard entry. ¥ [~ &[] [F] V]
Also find buttons for return to default or last state.

Click blue connection block or arrow to jump to other end.

speedy HG503206beta2 wuwur.driveweb.com Page 11/20
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Upgrade savvy and speedy
Upgrade savvy with SFD Signal Flow Diagram.
Upgrade speedy with software options.
Process credit cards or Vouchers on-line or Coupons off-line.
" /To upgrade savvy go to the Commerce menu, select
Upgrade savvy, check the desired option and click OK.
"/ To upgrade speedy, right-click on the speedy icon, choose
Upgrade Device..., check the desired option and click OK.

™. Your selected options will appear in the Shopping Cart. Select
your method of payment.

"/ To process Vouchers, choose Pay>Online Via Vouchers in
the Shopping Cart. Enter Voucher codes on separate lines.

"./To process Coupons click Buy and forward the code to your
drive.web distributor. When you receive your coupons go to
the Commerce menu and choose Coupon Manager. Enter

codes in the top box and click the Add button. Click Apply.

savvy-SFD Signal Flow Diagram Upgrade

" With savvy-SFD, build systems graphically while
creating live drawings that are stored in your speedy.

".Set borders with user attributes, drag and drop - - - |
connections, zoom, pan, cross-reference and annotate - 2 5577 ;
multi-page drawings. drive.web We78347.1

™. Right-click in an empty area of the SFD to zoom, add a  ueesmse "
new function block or note or to paste a parameter for  # 1 Fast smarty
convenient viewing.

™A filterable list of function blocks and connections is at
the left of the Signal Flow Diagram showing 5=
program execution order from top down. The 8 commssener
order in which function blocks are processed can & sme o
greatly influence system performance and the

function of logic engines. Change execution order by == tuc pase tockas

dragging function blocks up or down the list. In this == ehase tockes
picture, ENC1 Speed function block and its outgoing ~*

i
Al =N

. . 5 PUESD70
connection will be moved so that they are processed 4 .som5075
after ENC Phase Lock. = masaz0.5079 0w | [

D Toimmenga
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savvyPanel Operator Station

Computers, Apple® mobile digital devices; iPad®, iPhone® & iPod Touch®
are operator touch stations with savvyPanel. Requires Windows(XP,
Vista, 7), Mac OSX, Linux(Solaris, Umbuntu, etc) or iOS.

™. Operator station data is located in the drive.web devices so setup is easy.

" Editing and building savvyPanel systems requires savvy SFD upgrade.

“““““ savvyPanel dwOption-26 must be installed in drive.web devices to
enable the full suite of tiles. A limited set is available without the option.

" JFind complete information on savvyPanel in the savvy User Manual.

Get savvyPanel Free from the Apple App Store®"
"..When your iPad or iPhone is connected to the internet with WiFi you are
connected live to a real drive system in our plant in Maryland, USA.
«Touch Roll Change button to reset the roll length.
wEnable all section switches; extruder, brake, winder
“Touch the Line Start button and watch the line
accelerate, run and then automatically slow to
stop at the required length.
" Touch Set Speed, Set Temp or Set Tension to
open the setter and make changes.
", /Touch the parameter name in the setter to get info
" /Touch page-link arrows to browse demo pages.
™. Drive the demo with savvy in your computer. In
the File menu > Demo Mode, choose Discover " o
Internet Demo Devices. o &

Three savvyPanel Page Types
Systems Page present with multiple savvyPanel systems discovered.
wA savvyPanel system may contain tiles from many devices.
A drive.web device may contribute to only one savvyPanel system.
””UWTouCh the systems button, [&) or &8 , in the window bar to access the
systems page from home page. Lock this button with home password.
Home Page is the first operator page in a savvyPanel System.
.Access home page from any operator page with the home button, ¥ .
This may be locked with the home password.
Operator Pages show graphic, page-link and parameter tiles.
Pagcs can be renamed. The name appears in the window title bar.
" View zooms to show all tiles, so layout strongly affects appearance.

Apple, iPad, iPhone and iPod touch are trademarks of Apple Inc., registered in the U.S. and other
countries. App Store is a a service mark of Apple Inc.
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. Line Speed

Three savvyPanel Tile Types

Parameter Tiles. Touch a settable parameter to
see its savvyPanel setter. Includes; slider,
keypad, 1x, 10x increment, default & revert.

S]

¥ @O O

".A parameter is settable if it is not read-only and 100.00 %
has no incoming drive.web connection. e -

" Meter tiles; digital panel meter, dial or bar Speed Setpoint
meter. Unipolar or bipolar. Full-scale or percentage.

", Indicator tiles. Variety of colors. Shows on/off, true/false state.

" Pushbutton tiles; colored momentary and lighted Start/Stop. e

" . Multi-position Switch tiles for enumerated parameters. B

Graphic Tiles - create diagrams with a variety of process elements. '

Page-Link Tiles - A graphic tile that is also a touch page-link.
Function Blocks Enable savvyPanel Actions oK

‘Water Cycle
" Enumerated Parameter block in Utility group. Only custom
enumerations appear in the setter and multi-position switch. .

" In the savvyPanel function block group:
Latch and SR Latch support lighted start-stop pushbuttons.

Start at Next

Speed + Setpoint
Setpoint & Monitor blocks control meter range. Setpoint
clamps setter. Dual blocks enable dual display meters
savvyPanel Launch, Setup and Important Notes
105.00 %

"..See the savvy User manual for detailed instructions.

" Launch savvyPanel from a command line or batch file.

., Limit operators to savvyPanel-only, specify start system & page.

"Discover devices specifically by discovery file, automatically or «usespean
filtered by group and/or savvyPanel name.

"..Operator’s Note: If communication with a drive.web device is
interrupted, affected tiles indicate a yellow bar at top with an
exclamation warning. The displayed value is not updated. 100.00:%

A Important Design Note: An over-range enumeration is required if
misreading an out-of-range value could cause a hazard.

speedy HG503206beta? wwuw.driveweb.com Page 14/20
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speedy Comms Interfaces-Modbus & EIP/PCCC

Warning! Use of speedy comms interfaces, ModbusTCP,
ModbusRTU and EIP/PCCC, may cause motors and machinery to
power up with high Voltages or start or operate in an unexpected,
dangerous or lethal way. It is essential that you are completely familiar
with the Ethernet server protocol and all of the equipment and the
system design you are working with before attempting to use this
option. It is also essential that a risk assessment is conducted to identify
hazards. Risks must be reduced to tolerable levels.

" For info on Modbus specifications go to http://modbus.org/specs.php

" .Boolean values are 0 or 1. Non-zero values are Boolean true.

speedy Ethernet Server Support, Options 04 & 25

"..Click the Comms Server icon in the
FBE or SFD view to configure.

" .Comms Server Indirect parameters are
sequentially numbered. Enter any |[= 55
parameter numbers to read or write
them all with one operation. Add more
with Comms Server Indirect function
blocks in the Utility list set. You can | | _* _
directly address any parameter. You are vl T
NOT required to use them.

"..Comms Watchdog function block, available in the Utility
function block list group, can only be written via Modbus
comms. Write non-zero value to Input to keep Output = OK

™., Note! You cannot write or force parameters that are read-only
or have incoming drive.web connections.

speedy Option 04 ModbusTCP/IP Slave/Server
™. ,Standard option, included.

" .ModbusTCP Slave Port 502 is standard specified in protocol.
Change it in the unusual case that the master is non-standard.

"..Modbus Function Codes FC 01-06, 15 and 16 are supported.

™. .Supports up to five simultaneous clients/masters.

minator Stage 2
= kommsSﬂver

speedy HG503206beta2 wuwur.driveweb.com Page 15/20



drive.web automation

speedy Option 25 EIP/PCCC Server
™. .Supports EIP/PCCC. Typed-Write and Typed-Read functions.

" .See Appendix B of savvy User Manual for information,
examples and drive.web to PLC parameter mapping.

™. .Supports up to two simultaneous clients.

ModbusRTU Master & bus-share drive interface
Adding network devices may affect dedicated drive’s serial link performance.

" .Modbus Function Codes FG 01-06 and 16 are supported. Also
Yaskawa Holding Register function.

"..Note: Modbus address 1 is the dedicated drive’s address for
dweee, dw2e3 and dw226. dw225’s dedicated drive is
address Ox1F or 31. Bus-sharing Modbus servers must use
different addresses.

Comms Port function block

Comms Speed Read-only for drive-dedicated g Laminator stage 2
speedy’s. dw220, choose standard [ Comms Fort 13110
speeds are enter baud rate 0.1 to 500Kbps.

Comms Configuration Read-only in
dedicated speedy’s.
Character frame is 1-8-Parity-Stop:
Parity is N None, O Odd, E Even,
§ Space(0) or M Mark(1).
Number of Stop bits; 1, 1.5 or 2.

Minimum Comms Silence. 1dle on-the-wire time before a new
request 1s sent. Some devices require longer than minimum 3.5
characters. Longer times decrease comms efficiency.

Bandwidth. Drive-dedicated models only. The portion of the
bandwidth allocated for all Modbus Data blocks.

Actual Polling Period. Read-Only. Time required to poll all
parameters in all Modbus Data blocks with that priority.
Period is directly affected by number of parameters, silence
times and any errors or timeouts.

Comms Timeout. 10 to 30000ms waits for a reply. Status
indicates Timeout if no reply is received.
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drive.web automation

ModbusRTU Master - Comms Port function block continued..
Status. Any Last Error in Modbus Data blocks. Click to Reset all.
Enable. Globally enable and disable all Modbus Data blocks.

Modbus Data blocks, Boolean, INT16, UINT16

Define the data point, register, discrete or coil and o Laminator Stage 2

the slave or server device. Create up to 32 data Modbus Data INT1685103 :

blocks. Addresses can be changed dynamically. e K5 l
Boolean block’s Value can be True(1) or False(0). 3 -
INT16, 16-bit Integer, Value is £32767. e e

UINT16, Unsigned 16-bit Integer, Value, 0 to 65535. ki v |

Modbus Address. Unique address, 1 to 247 of b o |
individual server device.

PDU Address identifies the parameter, coil, discrete or register
number in your server to read and/or write to/from.

Enable Dynamically disable block when unneeded to reduce
polling periods.

Last Error enumerates last error detected. Click to Reset.

Modbus Type. ModbusRTU function supported by your server.

Priority Three levels. Round-robin scheduler processes all High
priority data blocks plus one other every round. All Medium
priority blocks are processed, one per round, then first Low
priority block. Following rounds process all Medium priority
blocks again then next Low priority.

Value. Raw decimal read/written to/from the remote parameter.

speedy Option 06 Winder Control Library

Accurate speed calibration of all components in a winder system is

essential before commissioning.

Diameter Calculator Block. An instance of this block is
required for Taper Tension and Torque Compensator
blocks. Associate a Diameter Calculator in those blocks.

Taper Tension Function Block. A positive setpoint reduces
web tension as the roll diameter increases.

Torque Compensator Block. Set Forward/Reverse Line
Direction friction compensation, Unwind/Rewind and Wind
Forward/Wind Reverse modes. Friction and Inertia
Compensator buttons set Stiction, Static Friction & more.
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savvy overview

------- Device Group Device| ,.*
e o o o+ savvyPanel System | Name
--mem Example °

Device Directory ‘e

Discover devices when savvy
launches or by using the .
Directory menu. Discover by; .
group, savvyPanel system, .

Discovery file or all local devices
automatically or by request.

.
ROWa;e[ Air gugl,&-saa:mce Press Ops
..............0....I.....
(XN

4

. Al. Extruder Exlruderswamgr;enl Unwind/Rewind

“ e s .eedlTouch or Click

Function Block Engine Standard savvy savvy-SFD
With standard savvy, the device P Guudes Management ]

overview screen gives access to
Comms Server setup, Function
Block Engine and native device 4

. . 8 o
functions where applicable.
With savvy-SFD place function { LG
blocks graphically, use function }_—..-‘\; o]

il

block list to review and arrange
e e e

execution order. A P - 4
4 Touch or Click
3 Extruders Managemen ’

Function Block 2-In Switch@5018

View functional elements and T
oo

=

signal paths in relation to
parameters. Parameters show
type, drive.web connections,
read-only and not at default
adornments.

Right-click on parameter,
“Copy Parameter”
J

Right-click on parameter
“Add to Parameter Dock”

Parameter Dock
Add parameters of interest to set,
view, create trend graphs and
export .csv files for spreadsheets.
Save docks and open multiple

docks in different viewer
windows. |D0ck menu > Show Trend|

//.v e
=

" Suan Zoom Marauee

Paste Parameser

Show Trend Pont Info




savvyPaneI overview
Systems Page
View all available
savvyPanel systems. Assign
savvyPanel a savvyPanel system in
Systems ‘ cach device’s contextual
= =54 menu, one per device. If a
R R |~~~ “ © '. 1 savvyPanel password is set
N x f in the device, it must also be
! added in savvyPanel

savvyPanel Password is not - i
’ y Touch or Clle operator station software
1

set in savvyPanel operator under the savvyPanel menu

e 0006000000 ] ders West HI-SpeedPrtss

.....................;........

station. No savvyPanel 1 3 5
data is shown. ystems button.
* *m ? Requires Home Password if set.
- i 'i' Home Page
The master page for a
YN 5 : savvyPanel system. Similar
B | ® to operator pages except that

it may be accessed from any
operator page by pressing the
home button. Graphic tiles
can be page links.

Touch or Click
Page-Link (Y : — * * 9

Home Button.
Requires Home Password if set.

A Operator Pages

System OK Speed Setpoint Up to 256 possible. May be

R R page-linked in any way. Set
savvy preferences so that
Rl%hlt'dlfk m ar(liempty operators view a specific page
grid focation an at launch. Use this preference
Paste Parameter”.

and the home password to

Choose desired graphic. :!,5':::‘, restrict access to the home
. o page and pages linked only
112.59 Eh from the home page. Provide
M\\m ——————— | links to the home page to
s bypass the home password.
°C home password then only

restricts access to the systems

page.
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Drives and Automation
Call 800-848-2504
.emainc.ne

driveliies ‘product line highlights

Drive-dedicated smarty and speedy models are
available with complete, one-cable drive interfaces.

Supported Drive smarty Model | speedy Model
Generic dw210 dw220
PL/X Digital DC Drive dw211 dw221
Optidrive P2 dw214 dwez4
Optidrive Plus dw213 dw223
Optidrive HVAC dw216 dwez26
Optidrive E2 dw2il2 dwe22
Optidrive E2 Single Phase Output dweilz2 dwz222
YaskawaF7 dw215 dw225

Peer-to-peer drive.web connections over Ethernet
enable distributed control and open scalability.
smarty® DIN rail drive.web controller.
Sixteen flexible, bipolar-analog / digital I/O
Hardware options; dual serial-ports, add six
digital inputs, frequency I/0O, relay-rack
control, remote module comms.
External options; dual encoder module with re-
transmit, high-Voltage 1/0.
Encoder control library with cyclic and linear
positioning and electronic line shaft support
savvy-SFD Signal Flow Diagram upgrade, see page 13.
savvyPanel operator touch station app, see pages 14 to 17.
All drive.web products are designed & assembled in the U.S.A.
Get expert drive.web help. Call or email techsupport@driveweb.com

drive.web training courses

Free online interactive training seminars take about one hour.
Specialized online and factory training sessions are also available.
To register email training@driveweb.com or call.

drive.web 40 Log Canoe Circle, Stevensville, MD 21666 USA.
Ph. 410-604-3400, Fax 410-604-3500, wwuw.driveweb.com




